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ABSTRACT 

 

An essential part of any student’s curriculum in nuclear engineering is 

performing radiation detection experiments to gain a better understanding of the physical 

processes that are occurring.  However, not all institutions are capable of providing the 

equipment or radiation sources necessary for such labs, nor do long-distance students 

have the ability to readily access these facilities.  This research seeks to help remedy this 

problem by developing and testing a remotely accessible radiation detection laboratory 

system.  Through this work, a student can connect to the experiment station via remote 

desktop and then conduct a variety of radiation detection experiments. 

This research is a proof of concept for the implementation of a remote lab that is 

accessible through an internet connection.  The system consists of a host computer, 

attached radiation detection hardware, motorized equipment to allow manipulation of the 

lab elements, and a camera to provide visual feedback to the students.  As part of 

distance laboratory courses, students would remotely access the host computer and 

conduct the experiments from their location.  In this work, three different experiments 

were set up on the system and tested.  The experiments were the identification of an 

unknown source using a sodium iodide (NaI) detector, determination of uranium 

enrichment using a high purity germanium (HPGe) detector, and dead time 

determination with a Geiger-Müller tube. 
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NOMENCLATURE 

 

API Application Programming Interface 

eV Electron-Volt 

FWHM Full Width at Half Maximum 

GM Geiger–Müller 

HPGe High-Purity Germanium 

IT Information Technology 

LEU Low-Enriched Uranium 

MCA Multi-channel Analyzer 

MID MCA Input Definition 

NaI Sodium Iodide 

NEMA National Electrical Manufacturers Association 

NID Nuclide Identification 

ROI Region of Interest 

VI Virtual Instrument 
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1. INTRODUCTION  

 

1.1 Motivation 

With the modern marriage of online communications and traditional education 

institutions, the opportunities for education are greater now than they have ever been.  

The internet and online information databases have allowed the propagation of 

information and research to accelerate at a breakneck pace.  However, even with these 

advances, the institution of education itself remains remarkably difficult to free from its 

physical limitations.  After all, to receive a higher education it is usually necessary to 

uproot and move to an educational institution for several years, which poses a significant 

hurdle for many.  Not all prospective students have the means or funds to relocate 

themselves across the country or, potentially, the world for years at a time.  Additionally, 

not all education institutions may possess the resources necessary to provide for a high-

quality learning experience in certain courses, while the institutions that do are unable to 

share them. 

The solution to these issues has been distance education.  Distance education is, 

in short, any delivery mode for education in which students and teachers are separated in 

space or time.  Far from a 21st century invention, distance education really got its start 

when reliable postal services were established (Mood, 1995).  However, education by 

mail could never truly compare to a traditional format, hampered by the delay inherent to 

mail services and the difficulties this brings to correspondence.  With the advent of the 

internet, however, distance education became a serious consideration for universities.  It 
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became possible to offer courses at a distance that stand on par with those offered in 

person.  Currently universities have been successful in providing quality distance degree 

programs to students who would otherwise be unable to participate (Getchell, 2014), 

though by no means are all degrees offered.  Distance education still has a great deal of 

room for development. 

Texas A&M University offers a variety of Master’s degree programs for distance 

education, including a number of Master of Engineering degrees. However, during the 

time this work was executed, nuclear engineering is not among them (Texas A&M 

University, 2017).  Given the relative rarity of nuclear engineering programs (of all 

engineering disciplines, only petroleum engineering has fewer accredited programs (U.S. 

News, 2017)) due to the prohibitive costs and legal difficulties involved, it is unfortunate 

that one of the departments that could stand to gain the most from being available for 

distance education is largely unavailable.  A handful of online nuclear engineering 

programs exist, but they are mostly bereft of lab classes, often featuring simulations at 

best.  Penn State’s online nuclear engineering course, for example, has a single 

laboratory course that is only necessary if a student does not meet certain prerequisites, 

and must be performed on-site anyway (Pennsylvania State University, 2017).  

Laboratory experience is an important component of any nuclear engineering program, 

and to remove it in its entirety would be unfortunate.  In order to address this issue, the 

creation of resources to allow for distance lab courses is necessary.  
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1.2 Research Objectives 

 The main goal of this research was to prototype and test a laboratory system that 

enables remote access to a variety of radiation detection experiments, with flexibility for 

further expansion and adaption in the future.  This was done through the assembly of the 

system’s host computer and software, adding and assembling controlled motor 

components and radiation detectors to the system to allow for the completion of several 

radiation detection experiments, and then completing these experiments remotely 

through the use of the system. 

The foundation of the system is a host computer that holds the necessary 

software, controls the lab equipment, and is in turn controlled by the distance student.  

From here, the system is expandable, with the ability to add additional controlled 

components, detectors, and other features as is necessary to allow for experiments.  An 

important feature of this system is that it must be easy to use and difficult to misuse; 

students should have as little exposure as is reasonable to the code and extraneous 

features of the system and its software. 

Three test experiments were designed and tested on the system, each covering a 

different aspect of radiation detection.  This ensures the adaptability of the designed 

system and demonstrates its applicability to a range of radiation detection experiments.  

The three experiments that were tested are: 1. Source identification and quantification 

using scintillation detectors; 2. Uranium enrichment calculation with HPGe detectors; 

and 3. Dead time determination with GM detectors.  Each of these experiments was set 

up by the author and conducted by a distance student through their internet connection.  
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At the conclusion of the experiments, feedback was used to improve the system and set 

clear objectives for future developments on it. 
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2. PREVIOUS WORK  

 

Attempts at solving the problem of bringing lab coursework into online degree 

programs have been made many times and with a variety of proposed solutions.  Among 

these solutions are virtual labs and remote labs.  Both of these are made with the goal of 

allowing students to receive a lab experience or something very close to it without 

requiring that the student physically be present at the university.  Both can be completed 

over the internet. 

Virtual labs are effectively an experimental simulation.  The student is given a 

program that allows them to manipulate elements of a virtual lab.  The system will adjust 

and produce results based on the user’s set parameters (Son, Narguizian, Beltz, & 

Desharnais, 2016).  While the experiment in question is not being physically performed 

in real time, this is meant to give the student a close approximation to what will happen 

when it is performed.  Obviously this has some weaknesses; since the experiments are 

programmed and not being performed live, results are deterministic.  There is little 

opportunity for students to run into the same challenges that can occur when attempting 

such experiments by hand.  Another difficulty in the implementation of virtual labs is 

that, since they are entirely computerized, each experimental detail needs to be custom-

made.  There is little room for re-use from experiment to experiment, meaning more 

work needs to be put into the creation of each simulated experiment.  Despite the 

challenges, implementations of virtual labs can be seen throughout the academic world.  

For example, a virtual physics lab course was put into practice at the International IT 
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University in Kazakhstan, featuring a full suite of virtual experiments for physics 

students (Yevgeniya, Viktor, & Madina, 2017).  

Another approach to online laboratories is in presenting the experiments to 

students through video.  Such a system was presented and student-tested for a physics 

course at the University of Camerino in Italy (Amendola & Miceli, 2016).  In this 

approach, students are given a video recording of the experiment being conducted by an 

instructor.  Students then take the data from the recorded lab, analyze the data, and 

present a report based on their findings.  While this is an approach that is simple and 

quick to set up, it does mean that the students have no real opportunity to conduct the 

experiment themselves; they are only observing, not actually working with the lab 

elements. 

Remotely controlled labs for the purpose of distance education are not unheard 

of, even in the field of nuclear engineering.  In 2011 a similar remotely accessible 

radiation detection lab was implemented at Clemson University for the purpose of 

potential on-line radiation detection courses (Kopp, 2011).  Similar to this work, the lab 

at Clemson utilized a host computer and software-controlled motor components to 

manipulate lab elements.  Major differences include that the Clemson lab utilized 

custom-written LabVIEW programs in order to analyze radiation detection data from the 

MCAs.  This has the effect of making implementation expansions difficult, and has been 

made largely unnecessary with the improvements in modern commercial radiation 

detection software.  Additionally, the online implementation of the experiments was not 

remotely tested; experiments were performed from the host computer itself.  When this 
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thesis was written, it did not appear that an online degree program involving radiation 

detection has been implemented at Clemson University (Clemson University, 2017).   
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3. SYSTEM COMPOSITION 

 

3.1 Host Computer 

 The core component of the remote laboratory is the host computer.  This is the 

computer students will connect to via Windows’ Remote Desktop Connection and use to 

control the experiment apparatus.  The computer used for this project was a Dell 

Precision T3500 running Windows 7.  The full specifications of the computer are shown 

in Table 1 (Dell Inc., 2010). 

 

Processor Intel® Xenon® W3503, 2.40 GHz 

Operating System Windows 7 Enterprise 

Memory 4.00 GB, 1333 MHz 

Chipset Intel X58 

Internet Ports Two Broadcom NetXtreme Gigabit 

Ethernet Ports 

Table 1 – Host Computer Technical Specifications 
 
 

In addition to the laboratory software detailed in the following sections, this 

computer has Remote Desktop capabilities enabled and was connected to two separate 

networks: a local area network comprised of the host computer and the experimental 

system components such as motors and detectors, and the Nuclear Engineering 

Department’s network.  Remote students connect to this computer through this second 

network.  The component network is only accessible through the host computer.  
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Students connecting to the computer need to have an online account with both Texas 

A&M University and the nuclear engineering department.  In addition the student must 

be registered to the computer’s list of permitted remote desktop users by IT in advance, 

or they will be unable to connect.  This prevents unauthorized users from accessing or 

tampering with the lab system. 

3.2 Canberra Genie 2000 

 A critical piece of software in the host computer is the Genie 2000 spectroscopy 

software, developed by Canberra for use with their radiation detection devices.  This 

suite of programs allows students to interface with the detectors used in the experiments, 

change the settings, and record radiation detection data.  The most frequently used 

program in this software suite is the Gamma Acquisition and Analysis program, which 

can be coupled to any Canberra MCA. 
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Figure 1 – User interface for Genie 2000 Gamma Acquisition and Analysis. 

 

A picture of the Gamma Acquisition and Analysis program is shown in Figure 1.  

The recorded radiation spectrum is displayed in real time in the black box, while the 

results from the various spectrum analyses are output into the large white space at the 

bottom.  Information about the current spectrum is displayed below the spectrum box.  

This display area gives a variety of information and includes: 

• Time Info: Presents the time acquisition began, the dead time, the live time, the 

real time, and the total counts collected.  Real time is the total time taken during 

acquisition (live time plus dead time), while live time is the time for which the 

detector has actually been able to collect and record radiological data.  In other 

words, the live time is the real time with the dead time taken out. 
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• Marker Info: Genie allows the user to select regions of the spectrum by placing 

markers that surround spectral features (i.e. peaks).  These are called region(s) of 

interest (ROI).  The Marker Info field displays both the channel number and 

energy (if calibrated) for each marker and the centroid.  The integral and area of 

the ROI is given, along with an uncertainty value for the area. Here, the area 

represents the net counts in the ROI above background, while the integral is 

simply the total counts in the ROI.  Since the integral is just a sum of the counts, 

there is no uncertainty associated with it.  The field also provides the FWHM and 

the full width at tenth maximum. 

• Nuclide Info: Displays helpful information for identifying nuclides.  By placing 

the cursor on a point in the spectrum, Nuclide Info will display a nuclide identity, 

if any, that has a photon at that energy, along with its half-life and that photon’s 

yield.  Placing it in a highlighted ROI will also give the FWHM and area of the 

region much like the Marker Info field.  It can also estimate the activity of the 

nuclide, but will only if an efficiency calibration is supplied.   

• Sample Info: Displays what user-defined sample is being examined, giving 

details such as the sample title, ID number, type, quantity, and sample geometry.  

Genie 2000 does not attempt to fill out any of these entries by itself; it is up to 

the user to enter the pertinent information that is displayed here.  This 

information can be entered in the Sample Info option of the Edit menu.  The 

purpose of this field is to help keep track of previously recorded spectra, not to 

glean information about the spectrum being recorded. 
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In addition to the Info fields, Genie 2000 also has a suite of spectrum analysis 

tools under the “Analyze” menu.  These tools can be used for a variety of different 

purposes, including peak location, peak area computation, and nuclide identification.  

The peak location tools “Unidentified 2nd Difference” and “VMS Standard Peak 

Search,” along with the peak area tool “Sum / Non-Linear Least Squares Fit” are the 

ones used for this thesis.  According to Canberra, the Unidentified 2nd Difference 

algorithm “uses a modified 2nd difference computation over a user specified range of 

channels,” while the VMS Standard Peak Search also uses the 2nd difference method but 

then fits the peaks using a “pure Gaussian fit routine.” (Mirion Technologies, Inc., 2016)  

There is also an “Execute Sequence” submenu which contains tools that will 

automatically use several tools in sequence in order to produce results.  The one 

algorithm here used in this thesis is “NID Analysis w/Report.”  This sequence, when 

analyzing an efficiency and energy calibrated spectrum will attempt to determine what 

nuclides are present and in what amount. 

The other programs in Genie 2000 employed for this project are the MCA Input 

Definition Editor, the MID Setup Wizard, and the Nuclide Library Editor.  The first two 

programs are instrumental in creating the MID files which allow the Gamma Acquisition 

and Analysis program to connect to the MCAs used in each experiment.  The MID Setup 

Wizard program allows for streamlined creation of MID files.  The “Editor” program 

allows users to manually create new MID files and edit existing ones, although the 

process of creating new ones is not as streamlined as it is in the MID Setup Wizard.  

Ideally, students should not deal with these programs directly, but they are required for 
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instructors to set up the experiments.  Among other settings, the MID files set the bounds 

on a detector’s high voltage, and tampering with the settings can lead to unsafe operation 

and potential equipment damage.  These programs should only be handled by the 

individuals running the lab and the MID files should be created in advance for students.  

There are also some cases, such as with the Falcon 5000 portable HPGe detector, where 

a MID file is supplied by Canberra.  The Nuclide Library Editor is used to create custom 

nuclide libraries for use in Genie 2000.  These libraries define what Genie 2000 

recognizes as nuclides, including the energy lines it looks for.  Libraries can be entirely 

defined by hand, composed of nuclides taken from other libraries, or a combination of 

the two. 

3.3 LabVIEW 

 In order to physically manipulate the elements of each experiment, LabVIEW 

System Design Software from National Instruments was employed.  LabVIEW can be 

used for a wide variety of laboratory functions, but in this thesis it was used for motion 

control.  Using LabVIEW’s SoftMotion module, the stepper motors detailed in the next 

section can be controlled.   LabVIEW functions primarily through the use of its VIs, 

which are custom-made programs created through the LabVIEW API.  National 

Instruments describes VIs as “LabVIEW programs that imitate physical instruments 

(National Instruments, 2015).”  Each VI consists of a block diagram and a front panel; 

the block diagram is a visual programming environment, while the front panel is what 

the end user (i.e. students) interact with in order to use the program.  A block diagram is 

shown in Figure 2, while the corresponding front panel is shown in Figure 3. 
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Figure 2 – Block diagram for a LabVIEW VI. 

 

 
Figure 3 – Front panel for a LabVIEW VI. 

 

Designing a LabVIEW VI is relatively simple compared to typical programming 

endeavors.  Little knowledge of conventional programming languages and structures a 

needed.  A user interface is assembled on a front panel by adding various elements, 
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including buttons, switches, displays, dialog boxes, lights, and many more.  Each of 

these objects (that are not strictly decorative) can be either a control or an indicator.  A 

control is an object that the user determines the state or value of when the VI is running, 

such as switches, knobs, or text entry fields.  These supply the user’s inputs to the block 

diagram.  In the front panel shown in Figure 3, the menu labeled “Detector Position” is a 

control, as are the three buttons in the middle labeled “Start Move,” “Stop Move” and 

Stop VI.”  An indicator is an object that the user cannot directly change the state of, 

rather they display some output of the block diagram.  These typically take the 

appearance of lights, graphs, or text outputs (National Instruments, 2017).  The front 

panel in Figure 3 has two green circles on it, which are indicator lights.  The text fields 

under “error out” displays text outputs that provide information in the event that the VI 

encounters a problem of some sort. 

For every element placed on the front panel, whether a control or indicator, a 

corresponding terminal is created on the block diagram.  For example, the blue square on 

the left in Figure 2 labeled “Detector Position” corresponds to the menu control with the 

same name on the front panel.  The green square on the right labeled “In Motion” also 

corresponds to the indicator light with the same name on the front panel.  The block 

diagram is where most of the programming work takes place, and appears akin to a 

flowchart.  Terminals are the inputs and outputs for the block diagram, and the block 

diagram performs actions based on its inputs and commands the outputs.  The block 

diagram introduces a third type of terminal as well: the constant.  Constants are much 

like controls, except that they do not have a partner on the front panel; constants can 



 

16 

 

only be set in the block diagram.  These are used for any aspects of the VI that the 

designer does not want the user to be able to readily change.  Aside from terminals, there 

are a vast amount of “nodes” that can be placed in the block diagram which allows the 

VI to perform whatever function the designer wishes it to.  Nodes include flow 

statements such as “while” and “for” loops, functions that take inputs and produce a 

corresponding output, and even other VIs.  These nodes and the connections between 

them will make up most of the block diagram. 

During execution of a VI, each node will execute once it receives all of its 

required inputs, and will subsequently pass its data to all nodes connected to its output 

(National Instruments, 2017).  Since data flow starts from the controls and constants, 

program execution starts from those and moves to the immediately dependent nodes, 

then to the nodes dependent on those, and so on.  The VI shown in Figure 2 and Figure 3 

is used in the gamma spectroscopy experiment in this thesis, and the block diagram has 

been split up into Figure 4 and Figure 5 to help describe the process. 

 
Figure 4 – Part 1 of the rotary table VI used in the gamma spectroscopy 

experiment. 
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Figure 5 - Part 2 of the rotary table VI used in the gamma spectroscopy 

experiment. 
 

When executing the VI, computation begins on the left in Figure 4.  This is not 

because it is the leftmost part of the program (although VIs are commonly designed to 

flow from left to right for ease of use), but because that is where the first node is that has 

all its inputs fulfilled.  In this case, it is the node labeled “Line” which connects the 

motor for the rotary table to the VI when supplied with the motor’s network address 

from the connected constant.  The program process then enters a large box that defines 

the apparatus’s movement.  This box is a while loop, meaning that whenever execution 

reaches the end of the box, it will return back where it entered the box.  Also note the 

numeric constant “100” connected to a metronome node in the upper left corner of the 

loop.  These nodes cause the while loop to wait until 100 milliseconds have passed 

before restarting, with the duration of the delay being set by the “100” constant. 

On entering the loop, the first step in the sequence initiates the motor in the 

“Axis” node.  Since the “Enable Axis” and “Enable Drive” options are both set to true 

by constants and cannot be disabled by the user, they will never change and the motor 
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will always be enabled.  This node could be placed before entering the loop without 

changing how the program works. 

With the motor enabled, the program process then encounters the first of two 

true/false case structures, which are the two boxes inside the while loop with a “True” on 

the top of them. One is in Figure 4, while the other is in Figure 5.  These structures cause 

different nodes to be executed depending on whether they are supplied a true or false 

signal from the controls connected to them.  In this VI, both case structures contain no 

nodes for the false case (not shown).  If their corresponding controls are false (off) the 

program will progress past both cases without doing anything.  The first case is 

controlled by the “Start Move” button control.  When the button is pressed by the user, 

that control becomes true (on) for as long as the button is pressed, and the structure 

switches to the true case. 

With the true case, the program reaches the Straight-Line Move command node, 

also seen in Figure 4.  This command will give the motor a complete set of instructions 

to make a move to the specified point.  The user has set a position on the “Detector 

Position” menu, and each position in that menu corresponds to an integer, starting at 0 

and increasing by 1 for every position.  That integer is then multiplied by a constant to 

turn it into a position for the motor.  In this VI, 10000 units on the motor corresponds to 

ten degrees on the rotary table, so by making the position multiplier 45000, each 

subsequent integer on the position menu corresponds to another 45 degrees on the rotary 

table.  Note that the box labeled “10000 = 10 degrees” does not define how the units 

correspond to a real life rotation; that box is simply a comment to serve as a reminder for 
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the programmer, as the motor’s units are determined by the hardware.  With the position 

determined, two more constants supply the velocity and acceleration & deceleration 

values for the move.  These values are in unknown units, and were chosen because they 

allowed for adequate movement of the rotary table.  The final value required is a code 

supplied to the Line Move Mode option.  This is a code that determines how the 

Straight-Line Move node interprets a position input.  In the mode used in this thesis, the 

position is treated as absolute; a given position input corresponds to a specific end 

position for the motor.  This is opposed to the other major mode of operation, where the 

position input is interpreted as being relative to the motor’s current position.  It is 

important to use the absolute mode, to ensure that the motor will always rotate to the 

desired positions. 

Immediately after giving the motor instructions for a move, the next Straight-

Line Move node commands the motor to start its move.  Once this command is given, 

the motor needs no further instructions from the VI in order to complete its move, so it 

does not matter if this case structure returns to its empty “false” version (as is the case 

when the user releases the Start Move button).  Moving on to Figure 5, the second case 

structure contains a Straight-Line Move node with a “Stop” command.  This command is 

not necessary to make the motor stop once it has reached its destination, as it will do that 

on its own.  As with the case structure before it, this structure will only use the true 

version containing the node when the connected button control (“Stop Move” in this 

case) is pressed.  This button is used to stop the motor’s motion prematurely.  When 
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“Stop Move” is pressed, this “Stop” command will be sent to the motor, and the motor 

will cease its movement. 

After passing through both case structures, the program then encounters an Axis 

node that checks the position of the motor.  This position is output through Position 

Feedback, and is sent to a feedback node.  The feedback node saves inputs across loops, 

and here it is used to compare the position of the motor to its position from two loops 

ago.  If the two positions are not the same, the “In Motion” indicator light on the front 

panel will illuminate.  Lastly, the program moves to a status check. If the motor has 

encountered an error of if the user has pressed the “Stop VI” button on the front panel, 

the VI will end the while loop, display an error message (if applicable), and stop the VI.  

If this is not the case, the program returns to the beginning of the while loop.  Unlike the 

case structures, the Axis node and the status check will be executed every loop, as they 

do not rely on a user input to be evaluated by the VI.  

In summary, when the VI is started, it connects to the motor and enables it.  The 

VI will run through the while loop doing nothing except reading the motor’s position 

until the user presses any of the buttons.  Once the user presses the “Start Move” button, 

the VI commands the motor to make a move given the current position setting supplied 

by the user, then goes back to doing nothing but reading the position while the motor 

makes its move.  At any point the user may press the “Stop Move” button to cause the 

VI to interrupt the motor’s move, or the “Stop VI” button to stop the entire VI.  While 

this is just the VI used for the gamma spectroscopy experiment, the VIs used for the 
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other experiments in this thesis are very similar, only differing in how the position input 

is evaluated and the address of the motors. 

LabVIEW offers a variety of example programs that can be used as starting 

points for whatever application a user may have in mind.  Indeed, one of the highlights 

of LabVIEW is the wealth of premade VIs that can either be included in another VI or 

modified for a client’s purposes.  These example VIs can be found in the LabVIEW 

installation directory, under “LabVIEW 2015\examples,” and the VIs most relevant to 

this thesis are in the “motion” folder contained within.  In this thesis, an Axis Move VI 

was used as the basis for all of the motor control VIs that were employed to manipulate 

the Ethernet stepper motors.  The example VI was heavily modified to fit the needs of 

each experiment for this work.  In designing the VIs for this thesis, the guiding principle 

was that they needed to be as simple to operate as possible.  It should be intuitive to the 

user how to operate each VI, and there should be as few potential sources of errors as 

possible.  As a result, the VIs designed for this work were significantly edited to offer 

fewer options and settings to the end user compared to typical VIs.  Most of the existing 

controls were converted into constants, while new sets of controls were introduced to 

allow students to control the VIs within the desired limits.  For example, in the VI 

designed for the rotary table, all that is expected of the user is to pick a predetermined 

position and confirm movement.  Settings such as the motor’s IP address, movement 

velocity, and acceleration are already set and hidden from students. 
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3.4 Ethernet Stepper Motors 

 The motor elements of the lab are the Ethernet Integrated Stepper Motors, also 

produced by of National Instruments (ISM-7411E).  These are NEMA 23 size stepper 

motors controlled through an Ethernet connection.  These stepper motors offer a few 

features that make them the motors of choice for this work.  First, as these are National 

Instruments motors, connecting them to LabVIEW is uncomplicated as they are intended 

to be compatible with this program.  Second, being Ethernet-capable, there is no need to 

complicate the system with motor drivers.  They can be connected via LAN connection 

to the host computer and controlled by LabVIEW directly instead of having to use an 

additional piece of equipment to connect the devices.  Third, the specific model used 

comes with an encoder.  The important consequence of this is that the motor always 

“remembers” where it is; even if a VI is shut down or if the host computer itself is 

restarted, the motor will save its position.  Only a loss of power to the motor will cause it 

to forget its location.  This is an essential feature in preventing a loss of synchronization. 

Without it, it is possible that positions of lab elements could be incorrect, leading to 

incorrect motor positions or potentially running the linear slide off its rail. 

3.5 Rotary Table 

 The first of the two motor-controlled elements is the rotary table.  This part, 

shown in Figure 6, is a Velmex B4818TS Rotary Table (Velmex, Inc., 2016).  A rotary 

table allows for simple repositioning of lab elements, useful for things like selecting 

sources.  This rotary table also has NEMA 23 sized couplings, so as to properly connect 

to the stepper motors. 
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 This particular rotary table was chosen due to its reliability and durable 

construction.  This being a radiation detection lab, it was a reasonable expectation that 

lead shielding would be employed on the table at some point.  Thus, a rotary table with a 

high weight capacity was desired, and the Velmex B4800TS series rotary table met that 

criterion with a 200 lb. weight limit. 

 

 
Figure 6 – Rotary table coupled with one of the stepper motors, both size NEMA 

23. 
 
 

3.6 Linear Slide 

 The second motor-controlled element is the linear slide. This part, shown in 

Figure 7, is a 36 inch LinTech 140 Series Belt Driven Linear Actuator (LinTech Motion 

Control, Inc., 2017).  The linear slide allows for linear movement, useful for 
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repositioning components and, for example, altering the distance between a source and 

detector.  As with the prior parts, the linear slide also accepts a NEMA 23 size motor. 

 This linear slide was chosen for its flexibility and affordability.  Since the 

amount of weight this apparatus would need to carry are far lower than that for the rotary 

table (as there is no real need to place more than a single block of lead on it) a more 

lightweight and less costly model was desired.  When using this component, it is 

important that one does not drive the platform too far to one end or the other.  

Attempting to drive the platform beyond its end bounds could cause damage to the 

device.  Therefore it is important to design the LabVIEW programs such that a student 

cannot accidentally drive the platform too far, this being another reason why it is 

important that the stepper motors have encoders on them. 

 

 
Figure 7 – Linear slide coupled with one of the stepper motors. 
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3.7 Camera 

 The final part of the system is a camera and is more of a convenience for the 

student than a necessity.  This camera allows the student visual feedback when moving 

lab apparatuses.  The camera used was a Logitech C270 webcam.  Students can open the 

camera application on the host computer in order to see the experiment taking place and 

receive visual confirmation that lab elements have moved as expected.  It is important to 

note that the camera must be prepositioned by those managing the laboratory so that the 

experiment may be completely seen by the remote student.  It is recommended that 

students use the camera in its lowest resolution mode to ease the strain on the remote 

desktop connection.  This still allows for ample viewing of the lab. 
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4. EXPERIMENTS  

4.1 Gamma Source Identification 

 The first experiment setup for the remote laboratory was for gamma source 

identification.  When this experiment is assembled, students are supplied with a selection 

of common gamma check sources laid out on the rotary table.  A NaI scintillation 

detector is attached to a Canberra Osprey MCA, which is in turn connected to the host 

computer.  The detector is situated above one corner of the rotary table and shielded 

from the rest of the table with lead blocks.  A picture of the setup is shown in Figure 8, 

and a full procedure for this lab can be found in Appendix A. 

 

 
Figure 8 – The setup for the gamma source identification lab. 

 

The goal of this experiment is to familiarize the student with Genie 2000 and 

common scintillation detectors.  Students must start Genie 2000 and load the detector, 
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apply the high voltage, and then use a set of check sources to calibrate the MCA.  

Switching between sources is accomplished by the use of a LabVIEW VI (Spectroscopy 

Stepper.vi) which controls the rotary table.  The VI lists positions, not sources.  The 

experimental procedure for the students will list which source is in which position, so 

teachers can assign sources as they see fit.  To choose a source, students need only select 

its position and confirm.  The rotary table then moves the selected source into position 

under the detector.  During the calibration procedure, students are directed to record the 

energy, centroid channel, area and uncertainty of each of the photon peaks.  Once the 

energy calibration is completed, students then select an “unknown” source.  The student 

identifies the unknown radionuclide by determining the energy of each peak present in 

the calibrated spectrum. 

Much of this lab revolves around the energy calibration of the NaI detector.  In 

order to perform an energy calibration, it is necessary to have known radiation sources, 

preferably with photon emissions that are both high in abundance and with energies 

spread throughout the recorded spectrum.  For this laboratory the sources used were 

137Cs (662 keV), 60Co (1173 and 1332 keV), 22Na (511 and 1274 keV) and 133Ba (80 to 

300 keV).  The peaks in the spectrum produced by each source can be linked to the 

known energy for their corresponding photon emissions.  By doing this for multiple 

sources to get photon energies all along the MCA’s spectrum, an energy calibration 

curve can be determined, making every channel accurately correspond to some radiation 

energy.  This also influenced the choice of radiation sources in this lab; 137Cs is a 

popular mid-range source, 60Co and 22Na have their gammas at higher energies over 1 
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MeV, and 133Ba has many gamma decays in the lower energy ranges from 80 keV to 300 

keV. 

Genie 2000 makes the process of calibration significantly easier for the user, 

simplifying the entry of calibration data points and applying the calibration to the 

spectrum automatically.  In the “Energy Only Calibration” tool, the user enters the 

energy of a gamma peak and the corresponding channel.  As this option estimates the 

FWHM and does not utilize nuclide libraries, this is only recommended for an initial, 

rough calibration in order to make further refinement of the calibration easier.  In the 

“Energy Calibration By Nuclide” option, the nuclide being counted can be chosen, and 

the user can either have Genie 2000 automatically fill in the channels for the nuclide’s 

peaks or fill it in by selecting the peaks by hand.  The user can only use the automatic 

option if at least a rough calibration has been performed, or Genie 2000 will not be able 

to locate the appropriate peaks.  At any point, the calibration curve being used can be 

examined with the “Energy Show” option.  An example Genie 2000 calibration curve 

from this experiment can be seen in Figure 9. 

 
Figure 9 – The calibration curve produced in the gamma identification experiment. 
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A trial run of this experiment was conducted remotely.  The host computer was 

connected to from offsite and the camera software, Genie 2000, and the “Spectroscopy 

Stepper” VI were started.  The Canberra Osprey MCA was loaded into Genie 2000 and 

the detector was biased with 800 V.  The first step in this experiment was to set the 

“scale” of the spectrum (the maximum energy associated with the last channel in the 

spectrum) to 2 MeV and to start calibration.  A 137Cs check source was used for this due 

to its prominent gamma peak at 662 keV.  The Spectroscopy Stepper VI was used to 

rotate the 137Cs source into position and the source was counted.  During acquisition, the 

gain of the detector was adjusted until the peak from 137Cs fell close to a certain channel.  

Since the Osprey MCA provided 2048 channels and a 2 MeV spectrum was desired, 662 

keV out of 2 MeV corresponds to channel 678 out of the 2048, so 678 was the target 

channel.  This was calculated using Equation 1. 

CCs = ECs∗𝐶𝐶𝑆𝑆
ES

= 662 keV∗2048
2000 keV

 Eq. 1 

Where: 

ECs is the known energy of the 137Cs peak (662 keV); 

ES is the desired maximum energy of the spectrum (2000 keV); 

CS is the maximum channel number of the spectrum (2048); 

CCs is the target channel for the 137Cs peak. 
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Once the gain was set for a 2 MeV spectrum a 180 second spectrum was acquired 

so that spectral features such as the Compton Edge and backscatter peak could be 

observed and recorded by the student.  In addition, the Energy Only calibration tool was 

used to start the calibration process with a rough calibration.  The spectrum was saved 

and the experiment was continued. 

The VI was used to rotate the next source, 60Co, into position in front of the 

detector.  This source was also counted for 180 seconds.  After counting, the Energy By 

Nuclide List calibration tool was used to add the 60Co peaks at 1173 keV and 1333 keV.  

The spectrum was saved.  This process was repeated for 22Na and 133Ba, though the 511 

keV peak produced by positron annihilation from 22Na was not utilized in the 

calibration.  The final calibration curve produced was the one depicted in Figure 9.  With 

the calibration complete, the VI was used to rotate the last sources into position. These 

sources were the “unknowns,” with the goal being to identify them without looking at 

their labels.  These sources were also counted for 180 seconds. 

In order to identify the sources, the Interactive NID tool in Genie 2000 was 

employed.  A picture of the Interactive NID in use can be seen in Figure 10.  The 

Interactive NID tool uses a Genie 2000 nuclide library to provide a list of nuclides.  The 

library lists isotopes, associated photon emissions, photon yield, and the nuclide’s half-

life. The user can sort this list by nuclide or by energy.  When selecting any specific 

gamma in the list, the Gamma Acquisition and Analysis program moves the spectrum 

cursor to that energy.  Conversely, moving the cursor to a channel will cause the 

program to display any known gammas at that channel’s energy.  Whenever a gamma is 
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selected, the user has the option to “Show confirming lines,” which displays the 

locations in the spectrum of all other gammas from that nuclide.  Therefore this tool 

allows for quick selection and elimination of possible nuclides for a given peak in the 

spectrum; if a peak could correspond to some nuclide, but none of the other peaks from 

that nuclide appear, that nuclide can be rejected.  The half-life and abundance 

information can also be used to reject nuclides too short-lived or with abundances too 

small to be possible. 

 

 
Figure 10 – The interface for the Interactive NID.  The vertical green line in the 

spectrum is one of its confirming lines. 
 

The unknown sources were able to be successfully identified; the sources were 

57Co and 54Mn, and analysis of the spectrum’s peaks gave gamma energies within 1 keV 

of the expected values.  From the energies of the peaks in the spectrum, it was possible 

to identify the unknown sources by comparing them to known gamma radiation energies 

in conjunction with eliminating unreasonable isotopes with similar gamma energies.   
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There were a few complications involved in the construction and execution of 

this experiment.  The observed peaks were difficult to resolve in Genie 2000, which 

could be due to a number of reasons. One candidate is a flawed detector.  If a detector’s 

crystal is damaged in some way, this can lead to a loss of resolution, causing the 

recorded peaks to widen.  A damaged crystal may even split a photopeak, causing two 

almost indistinguishable peaks to be recorded.  Another possible issue may be in the 

Genie 2000 software itself.  The algorithms it uses to identify and quantify spectral 

features are designed around use with high-quality (HPGe) spectra and, while they can 

certainly be used for lower resolution spectra, they are less successful. 

4.2 Uranium Enrichment Quantification 

 The second experiment created for the remote laboratory was a uranium 

enrichment quantification experiment.  Here, several uranium samples of varying 

enrichment levels were placed on the rotary table, along with several gamma check 

sources.  A portable Canberra Falcon 5000 HPGe detector was connected to the host 

computer.  The detector was situated off to one side of the rotary table and was shielded 

from the samples with lead blocks.  Lead was also placed on the table to reduce spectral 

interference from other sources on the table.  As with the previous experiment, switching 

between sources was accomplished via a LabVIEW VI to control the rotary table’s 

position.  A picture of the experiment setup is shown in Figure 11.  A full procedure for 

this lab can be found in Appendix A.  
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Figure 11 – The setup for the uranium enrichment quantification experiment. 

 

 In this experiment, the goal was to provide students experience working with 

HPGe detectors and to conduct uranium enrichment measurements from gamma 

radiation measurements.  In the first half of the lab, students activated the HPGe detector 

and performed both energy and efficiency calibration using 137Cs and 152Eu.  They then 

used their calibration to identify and quantify an unknown source.  Once the system was 

calibrated, students collected a spectrum of a uranium source of known enrichment, 

followed by collecting the spectra of unknown uranium sources with unknown 

enrichments.  Students then used the simple comparator method to determine the 

enrichments of the uranium sample (Marianno, Lecture 7: Gamma Ray Spectroscopy 

with Semiconductor Detectors, 2016).  This method, shown in Equation 2, allows for a 

quick estimation of the enrichment of unknown uranium samples given a known sample.  
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For each measurement it is assumed that the size, distribution, container properties and 

position of the uranium samples are all the same, or the equation will not hold. 

 

�
Ck,235
Ck,238

�

�
Cunk,235
Cunk,238

�
=

�
Ak,235
Ak,238

�

�
Aunk,235
Aunk,238

�
         Eq. 2                    

 

 Where: 

Ck,235/Ck,238 is the ratio of counts in the 235U 186 keV peak compared to counts in 

the 1001 keV associated with  238U for the known source; 

Cunk,235/Cunk,238 is the ratio of counts in the 235U 186 keV peak compared to 

counts in the 1001 keV associated with  238U for the unknown source; 

Ak,235/Ak,238 is the estimate of the known source enrichment; 

Aunk,235/Aunk,238  is the estimate of the unknown source enrichment. 

By carefully counting both the known and unknown uranium samples the ratio of 

counts of 235U to 238U can be found for each sample.  The activity ratio of 235U to 238U in 

the unknown uranium sample (i.e. its enrichment) can then be solved for.  While 238U 

cannot be directly detected via gamma ray detection as its gamma emissions are all low-

energy (the largest is at 113 keV) and it has a very long half-life, it is in secular 

equilibrium with one of the products in its decay chain: 234mPa.  When this product 

decays it emits a gamma ray at 1001 keV, although the abundance of this gamma ray is 

low at around 0.84% (National Nuclear Data Center, 2007).  This will still be sufficient 
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for the method as it is the ratio that is important, and the quantity of 234mPa is directly 

proportional to the quantity of 238U. 

After remotely logging into the computer system the students use different 

components of the Genie software package.  First, they are directed to create a custom 

nuclide library using the Genie Library Editor.  To simplify analysis, the library only 

contains the nuclides used in this experiment (137Cs, 152Eu, 235U, and 238U) and excludes 

all other sources.  This nuclide library should be used for this experiment in lieu of the 

standard nuclide library used by Genie 2000. 

Once the library was created the student calibrates the detector, then identifies 

and quantifies an unknown source.  The apparatus is manipulated using the LabVIEW 

Uranium Stepper VI created for this experiment.  As before, the Gamma Acquisition and 

Analysis software was used to operate the detector and record data.  In Genie 2000, the 

MID file corresponding to the Falcon 5000 detector was loaded, and the bias voltage was 

set to 3000 V and turned on.  The VI was used to rotate the first source, 137Cs, into 

position in front of the detector.  The source was first used to set the gain of the detector 

to a spectrum range of 3 MeV.  Following the technique presented in the previous 

experiment, the 662 keV peak was placed in channel 1808 of the 8192 channel spectrum.  

After setting the gain, a 180 second count of the 137Cs source was taken, and the 

spectrum was used to begin the energy calibration of the detector. 

The VI was used to rotate the next source into position: 152Eu.  The source was 

counted for 300 seconds, and the spectrum was used to fill out the energy calibration of 

the detector further.  In addition, the 152Eu spectrum was used to calibrate the detector’s 
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efficiency as well.  With the known assay date and activity of the source, Genie 2000 

was used to create an efficiency calibration for the detector.  In order to verify the 

calibration of the Falcon 5000, the VI was used to rotate an “unknown” check source 

into position.  Using Genie 2000’s NID Analysis function, the source was successfully 

identified as 133Ba. 

The next section of the experiment focused on uranium enrichment 

determination.  During setup four uranium sources ranging in enrichment from 0.31% to 

4.2% were positioned on the rotary table, along with the check sources (Figure 11).  A 

natural uranium source, with 0.71% 235U enrichment, was the only uranium source of the 

four whose enrichment would be provided to students.  The ultimate goal of this section 

of the lab was to count the uranium sources and then use the collected data to determine 

the enrichment of the unknown uranium sources.  Each of the uranium sources, starting 

with natural uranium, were counted for 10 minutes each, using the VI to switch between 

samples.  An example spectrum of the natural uranium source is shown in Figure 12.  

Genie 2000 was used to perform an Unidentified 2nd Differential peak search to 

determine ROIs for the 186 keV and 1001 keV peaks.  This gave the counts and the 

uncertainty in the counts for each peak of concern in the spectrum. 
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Figure 12 – The radiation spectrum from the natural uranium source. The peak at 

A is the 186 keV peak from 235U, while the peak at B is the 1001 keV peak from 
238U. 

 

With the counts and corresponding uncertainties for the 186 keV and 1001 keV 

peaks, the enrichment of the unknown uranium sources could be estimated.  For the 

0.31% enriched source, the calculations came out to be 0.30% ± 0.02.  For the 1.94% 

enriched source the calculations came out to be 2.06% ± 0.07.  While the first unknown 

sample was determined to within a standard deviation, the second unknown sample was 

calculated slightly outside of a standard deviation.  The experiment was, for the most 

part, a success, as the experiment was successfully conducted remotely and with 

tolerable results.  Although the simple comparator method utilized in this lab may not be 
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suitable for situations where a high degree of accuracy is paramount, it makes for a 

quick and relatively simple method of estimating uranium enrichment.  It can allow the 

user to make a quick determination between, for example, natural uranium and LEU.  In 

future experiments, it is likely that the uncertainty could be reduced by increasing count 

times or improving the geometric efficiency of the detector-source setup, which would in 

turn give more accurate results. 

4.3 GM Dead Time Determination and Statistical Analysis 

The final experiment employed a GM tube to explore counting statistics and 

perform dead time calculations.  The purpose of this experiment is to introduce the 

students to GM tubes and beta radiation detection, as well as have them determine the 

dead time of the detection instrument. The dead time of a detector is the minimum time 

that must separate two detection events in order for them to be recorded as two separate 

pulses.  It is an important quantity in radiation detection, as it can heavily influence the 

recording of a spectrum if caution is not taken.  A detector receiving too many counts 

per second may have a significant amount of the detection time taken up by dead time, 

which means that much of the radiation that is actually entering the detector is not being 

recorded.  This is detrimental to the spectrum’s statistics and can impede any analysis of 

efficiency.  In addition, students will use this experiment as an opportunity to learn about 

counting statistics.   

This experiment brings the linear slide into play.  The GM detector is attached to 

the linear slide, while one part of a 204Tl split source is attached to the side of the rotary 

table.  The other half of the beta split source is stationary, situated so that the first half 
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can be rotated adjacent to it.  This setup is shown in Figure 13; the stationary source is 

visible on the right side, while the movable source is on the left side.   

 
Figure 13 – The split beta source setup for the dead time lab.  The source on the left 

(A) is movable and is affixed to the table, the source on the right (B) is stationary 
and just below the edge of the table. 

 

 
Figure 14 – The alignment of the movable and stationary beta split sources when 

the movable source is rotated to be adjacent to the stationary source. 
 

A B 
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To begin the setup of this experiment, the linear slide is positioned alongside the 

rotary table.  The result is that the GM tube can be moved between two positions with 

the stationary source at one position, while the source on the rotary table can be moved 

to either position.  Therefore, students can measure either source independently, both at 

once, or neither.  Although the detector is moved between two different positions in this 

experiment, care was taken to make the detection geometry at the two positions as 

similar as possible.  Shielding material was placed between the two positions to prevent 

sources at one position from interfering with counts taken at the other.  Though lead may 

be excessive shielding for beta radiation, it was in plentiful supply.  A Canberra Lynx 

MCA was used in this lab to analyze the signal from the GM tube.  Unlike in the other 

experiments in this thesis, the Lynx’s web interface was used instead of Genie 2000.  A 

picture of this interface can be seen in Figure 15.  The Lynx was used because of its 

ability to work with a wide variety of detectors as well as its attenuation feature, which 

allows it to handle pulses too large for most MCAs, such as those produced by GM 

tubes. 
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Figure 15 – An example picture of the web interface for the Canberra Lynx MCA. 

 

Students control both the rotary table and the linear slide in this experiment, with 

two separate LabVIEW VIs controlling each.  The rotary table VI is not the same as for 

the previous labs; to reduce potential confusion, the available positions have been 

reduced to just the two necessary for the experiment.  These VIs are shown in Figure 16 

and Figure 17, with the position menus opened.  The “Reset” option in the Linear VI 

moves the detector behind the shielding, Position A moves the detector to the left 

position away from the stationary source and Position B moves the detector to the right, 

in front of the stationary source.  The rotary table VI has two positions. Position 1 moves 

the movable source to the left position away from the stationary source, and Position 2 

moves the movable source to be adjacent to the stationary source, combining the split 

source. 
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Figure 16 – The front panel of the VI that controls the linear slide in the GM Tube 

experiment. 
 

 
Figure 17 – The front panel of the VI that controls the rotary table in the GM Tube 

experiment. 
 

Students use the Lynx MCA’s web interface instead of Genie 2000 in this 

experiment.  Using one of the halves of the split source, students solve a series of 

counting statistics problems.  First, students take 40 six-second counts of a single half of 
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the 204Tl split source.  From this, they are directed to calculate the mean of the 

population, the residuals of each count, and the standard deviation of the population as 

well as examining how the set of counts compares to their standard deviation.  Ideally, 

students should see that close to 68% of their counts fall within one standard deviation of 

the mean value.  After that, the goal is to experimentally determine the dead time of the 

detector.  Students take a background count, then count each of the sources 

independently for 30 seconds each.  The rotary table half of the split source is then 

moved adjacent to the static half, and the two sources are counted together.  With the 

count rate from each source in combination with the count rate from the joined sources, 

the students calculate the dead time using Equation 3 (Marianno, Lecture 4: Gas-Filled 

Detectors and General Detector Properties, 2016).   

                                       τ = M1+M2-M12
2M1M2

                               Eq. 3 

Where: 

τ = GM probe dead time (s)  

M1 = count rate for half-source 1(s-1)  

M2 = count rate for half-source 2 (s-1) 

M12 = count rate for the combined source (s-1) 

This equation assumes that the detector is non-paralyzable, which means that the 

detector will not prolong its dead time if radiation enters the detector before it recovers.  

Dead time will only begin after a successful count is made.  This equation is also a 

simplification of a more accurate and complex equation, which could lead to some 

higher uncertainty in the calculation.  However, since students are only trying to estimate 
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the dead time, and the difference between the two equations should be within an order of 

magnitude, this equation was seen as acceptable for the purposes of this experiment.  

Lastly, this equation makes the assumption that background radiation is low compared to 

the detection events from the source.  If the background detection rate was within an 

order of magnitude as the count rate of the source, the equation which takes the 

background into consideration should be used.  Once the students calculates their 

instrument’s dead time they are directed to compare the value to the manufacturer’s 

stated dead time.  A full procedure for this lab can be found in Appendix A. 

 This experiment was tested by connecting to the host computer from offsite and 

executing the experiment remotely.  The camera program, both of this experiment’s 

LabVIEW VIs, and the Lynx Web application were loaded.  The first part of the 

experiment was finding an operating voltage for the GM tube in the “Geiger” voltage 

region.  In this region, the amount of charge liberated by the incident radiation is 

constant, regardless of the energy of the radiation.  The detector was moved to the 

stationary source, and the movable source was moved away.  Starting with detector 

voltage at 500 V, the detector was set to record for 18 seconds, and the total counts in 

the resulting peak were recorded.  The voltage was increased by 25 V, and the counting 

and recording was repeated.  This was continued until 950 V.  Counts as a function of 

applied voltage were plotted and the GM plateau was identified.  The operating voltage 

was picked approximately halfway into the plateau at 850 V. 

With the GM tube’s voltage set, the next part of the experiment was to perform 

some counting statistics.  The detection time was set to six seconds, and a series of 40 
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counts was taken, recording the total detections for each count.  With all of the counts 

recorded, the mean of the population was calculated, along with all of their residuals 

(their difference from the mean) and the standard deviation of the population. 

The final section of the experiment was to calculate the dead time of the detector.  

The detector was moved using the VI to Position A where the movable source was.  The 

detection time was set to 30 seconds, and the count time, counts, and count rate were 

recorded.  The detector was moved back to Position B, and this process was repeated for 

the stationary source.  Finally, the rotary table VI was used to move the movable source 

back together with the stationary source, and both sources were counted at once.  The 

count time, counts, and count rate of the combined sources were also recorded.  From 

these three count rates, the dead time could then be calculated. 

In the statistics potion of the experiment, the average of the 40 six second counts 

was calculated, and the sum of their residuals was zero.  The sum of the residuals is 

expected to be zero as each residual is that count’s difference from the mean.  If the sum 

of their differences was not zero, then the mean from which they were derived could not 

be correct.  The standard deviation of the population, as this is assuming a Poisson 

distribution, was calculated by taking the square root of the mean of the population.  

When compared to the residuals of the counts, it was found that 55% of the counts fell 

within one standard deviation.  This was less than the expected value of 68%, but it is 

not entirely unexpected; a population of 40 counts can still have significant differences 

from an ideal population.  With the statistical analysis completed, the next part was the 

dead time determination.  Using Equation 2, the dead time was calculated to be 2.7 ms 
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with an uncertainty of 0.14 ms.  This was significantly larger than the manufacturer’s 

stated dead time of 80 μs, and while the short counting times may have contributed some 

inaccuracy to the results, it is likely there are additional causes for this.  While the 

experiment was successfully conducted, the results of the dead time calculation were 

poor, and indicate a need for improvements in the experiment. 
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5. FEEDBACK & CONCLUSIONS  

 

5.1 Feedback 

Input was received on how to make improvements to the system for the future.  

Much of the feedback revolved around connectivity issues.  The issue most reported by 

testers was that when the camera program is opened the connection quality drops 

dramatically.  While the “in motion” lights in the VIs mean the experiments can still be 

completed, it is rather unfortunate for a student.  Alleviating this may require a change in 

remote desktop software or investigating different methods to use the camera. 

Another issue was tied to the system’s resources, specifically what happens if 

they are not properly relinquished by a user.  Should any user of the system fail to 

properly close their programs when finishing their work, these programs are still 

considered to be in use by that user even after they log off.  This means nobody else can 

use the programs until they are freed from the first user.  This can be accomplished 

easily by restarting the system, but it is something that needs to be kept in mind.  A 

similar piece of feedback was what it takes to get a student or otherwise to be able to use 

the remote computer.  Each desired user needs to be manually given access by TAMU 

IT. This can sometimes take an extended period, but it at least adds a level of cyber 

security. 

This is related to another important issue as well.  Though it was not encountered 

during the work of this thesis, it is possible a student could log in to the experiment 

system and then sabotage it.  File permissions need to be set for future implementations 
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of this system to ensure that users cannot edit the files necessary for the system to 

operate and the software to run.  There is also the concern of copyright and export 

control related issues.  It may be possible for a user to copy program files from 

something like Genie 2000 to their computer, possibly including software under export 

control restrictions, which could lead to their unwanted transfer to other states. 

Improvements need to be made to the GM tube experiment especially.  The dead 

time calculation in the experiment did not perform up to expectations, but this may be 

remedied.  A new experiment setup may make it so that the geometry is shared for both 

halves of the split source, instead of the current state where they are set up to be as close 

as possible but are still separate and therefore subject to uncertainty.  The program of 

choice for analyzing the spectral data for the Lynx MCA may be a contributing factor as 

well.  The Lynx web app is not nearly as robust as Genie 2000, and it may be better to 

perform analysis through Genie 2000 instead. 

5.2 Conclusions 

 Three laboratory experiments were successfully constructed and then executed 

remotely by connecting to the host computer from off campus.  These experiments were 

made to test the ability of the system to host experiments that could be completed 

remotely, where the goal of the experiments was to give students experience with 

radiation detection. 

 The system was composed of a host computer, a rotary table, a linear slide, and a 

webcam.  The major software suites on the host computer were Canberra’s Genie 2000 

and National Instrument’s LabVIEW.  Genie 2000 was used to control and read data 



 

49 

 

from connected radiation detectors, while LabVIEW was used to control the rotary table 

and linear slide.  The webcam’s bundled software was also used in order to control the 

camera.  The rotary table and linear slide were used to physically manipulate the 

components of each experiment. 

The first of the experiments was the gamma identification lab, in which 137Cs, 

60Co, 22Na, and 133Ba were used to calibrate a scintillation detector.  With the detector 

calibrated, it was then used to identify an unknown source(s).  This experiment 

introduces students to gamma spectroscopy, the importance of calibration, and 

identification of unknown sources. 

 The next experiment was the uranium enrichment lab.  In this lab, students were 

provided check sources with which to calibrate the HPGe detector, as well as three 

uranium sources of varying enrichment levels.  Once the detector was calibrated, one 

uranium source was chosen as a standard.  By determining each sample’s ratio of 235U to 

238U from the respective gamma spectrum, the enrichment of the other two uranium 

sources was approximated by comparing their ratios to that of the standard.  This 

experiment gives students experience with HPGe gamma spectroscopy as well as 

uranium enrichment calculations. 

 The final experiment was the GM dead time determination lab.  This lab had a 

GM detector and a 204Tl beta split source.  One half of the split source was used for 

statistics problems; a set of counts was taken and the mean, residuals, and standard 

deviation were calculated.  The population was then compared to the standard deviation 

itself to see how many of the counts fell within it.  The dead time of the detector was 
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then experimentally determined.  Each part of the split source was counted individually, 

and then the two were counted together.  From these values, the dead time of the 

detector was then calculated. 

 With the three experiments completed remotely and the potential for the 

implementation of many more, this remotely accessible radiation detection laboratory 

shows considerable promise for full implementation in the future.  The experiments were 

possible to complete from an off-campus computer as desired.  That said, it is now clear 

that the system has its share of weaknesses as well.  Internet connectivity issues can 

plague the connection quality; over long distances, insufficient bandwidth can cause 

slow operation and interruptions which are frustrating to the student.  Worse still, a poor 

connection can cause the remote desktop application to kick out the user, which then 

requires a reconnection.  Even in this case, however, all programs remain running while 

disconnected and can be resumed with little difficulty once reconnected. 

 Another flaw of the current system as it stands is that it is dependent on students 

“cleaning up after their work.”  If a student fails to properly shut down equipment 

including the webcam and the detectors, other students logging on may be unable to use 

those devices.  As far as the computer is concerned, those resources are still claimed by 

the former account.  A software solution may have to be implemented to correct this 

flaw. 

 As the experimental capabilities seem to be sufficient and can be freely 

expanded, future work in this area should also be directed at devising further 

experiments to implement on the system.  A good candidate for a future experiment 
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would be with Compton scattering; students would be tasked with analyzing how 

scattered gamma radiation changes with the angle at which it scatters, both in energy and 

relative intensity.  Another possible experiment would involve neutron detection.  This 

could involve comparing the capabilities of 3He and BF3 detectors, and observing how 

shifting polyethylene blocks in the detector arrangement can influence the detection of 

neutrons (e.g. imposing blocks between the source and the detector.)  A significant 

challenge in the development of this technology would be the implementation of a 

mechanically challenging lab such as alpha detection.  A lab involving multiple alpha 

sources would require working with vacuums and complex actions on the part of the lab 

controls in order to properly exchange sources in the detector.  If this could be 

accomplished, however, there would be few remaining limitations on what nuclear 

radiation detection experiments could be accomplished by remote lab. 

There is significant need for improvements on the connection method.  Over long 

distances, the system as it stands suffers from a lack of visibility and sluggish response 

time.  Despite the complications, however, the system does work.  It is possible to 

physically carry out a properly set up experiment without being anywhere near the lab 

itself.  With this serving as the groundwork for future fine-tuning and expansion, 

bringing online nuclear radiation lab courses to Texas A&M could quickly become a 

reality. 
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APPENDIX A 

Laboratory 1 

Gamma Ray Spectroscopy Using NaI Scintillation Detectors 

Purpose 

The purpose of this laboratory is to study the use of NaI detectors for the measurement of 
gamma sources. The student will setup a NaI detector system using a Canberra MCA and 
spectrum analysis software, learn how to calibrate the system in energy, and identify an 
unknown source.  

Materials Needed 

The following will be provided by the instructor: 
1. A set of industrial sources
2. Experiment station computer
3. NaI detector
4. an OSPREY digital MCA

The student should have the following: 
1. an internet-capable computer
2. a calculator
3. your notebook
4. a copy of these procedures
5. a pen

Experimental Procedure 

The table below will help in the energy and efficiency for this experiment. 

Position 
Source 

Half life 
(yr) 

Energy 
(keV) 

Branching 
Ratio 

Assay 
Date 

Assay 
Activity 

1 Cs-137 30.07 662 0.85 08/2010 1 µCi 

2 Co-60 5.27 
1173 1 

08/2010 1 µCi 
1332 1 

3 Na-22 2.6 
511 1.8 

07/2016 1 µCi 
1275 1 

4 Ba-133 10.5 
356 0.62 

08/2010 1 µCi 
81 0.33 
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Connecting to the Experiment Station 

Your instructor will arrange for you a time to use the experiment station, an IP address to 
connect to, and login information for the experiment station.  Record this information, as 
you will need it to connect to the experiment station. 

 
Windows Instructions 

1. Connect to the Texas A&M network.  Help for this topic can be 
found at http://it.tamu.edu  
2. On your computer, open up the Start menu and search for Remote 
Desktop Connection and open it. 
3. Click on Show Options. Enter the IP address given by your 
instructor in the Computer: field.   
4. Click Connect. When asked for login information, choose Other 
and enter NE\username for the user name (where “username” is your 
NE account name), and your NE account password as the password.  
Your NetID will not work. 
5. You are now connected to the experiment station.  

 

NaI System Setup and Energy Calibration 

1. Open Canberra GENIE (search for Gamma Acquisition and Analysis), LabView 2015 
32-bit, and the Logitech Webcam Software.  Once in LabVIEW, click on “Open 
Existing” and navigate to and open the “Spectroscopy Stepper” program in 
“C:\LabVIEW Programs.” 

2. In the Stepper window, press “Run.” See Fig. A1. 
 

 
Fig. A1 – The Run button on the left end of the toolbar. 

 
3. In GENIE 2000, open the detector MID file “OSP##” and set the HV to 800 V. 

(MCA>Adjust>HV).   Turn on the HV. Select the Filter button. Set rise time to 0.800 
μs and flat top 0.2. Select the Gain button and adjust the LLD to 1.5%.   

4. Cs-137 Measurement. Select the first source (Cs-137) and press Start Move.  Wait for 
the source to rotate fully into position. 

5. Set the limit of your spectrum to 2 MeV by using ratios.  The channel limit on your 
spectrum is 2048.  In a 2 MeV spectrum 2 MeV = 2048.  At what channel should the 662 
keV photopeak from Cs-137 fall on?  Start acquiring a spectrum.  Adjust the coarse and 
fine gains until the photopeak is approximately at the calculated channel.     

6. Once the peak is near the specified channel, acquire a spectrum for 180 s 
(MCA>Acquire Setup). 

http://it.tamu.edu/
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7. Using the Canberra GENIE-2000 software, energy-calibrate the spectrum using the 662 
keV photopeak. On the menu bar select Calibrate – Energy Only Calibration.  The 
calibration window will open enter the energy and centroid channel number for the peak 
and click the Accept button.   Record the channel and energy information used in the 
calibration. 

8. Acquire the peak area(s) for the spectrum.  First go to Analyze> Analyze>Peak 
locate>VMS standard Peak Search.  Then go back to the Analyze>Peak 
Area>Sum/Non-linear LSQ Fit…. Record the net count rate and count uncertainties. 

9. Identify the channel number and energies for the following spectral features: backscatter 
peak, Compton edge and photopeak. 

10. Co-60 Measurement. Select the Co-60 source and press Start Move.  Wait for the 
source to rotate fully into position. 

11. Acquire a spectrum for 180 s.  
12. Using the Canberra GENIE-2000 software, energy calibrate the detector system using 

the two photopeaks from Co-60.   You can do this by going to Calibrate>Energy 
Full>By Nuclide List.  Be sure to check the “append to existing calibration,” or the Cs-
137 calibration will be lost.  Select Co-60 from the list.  Another window will appear 
listing the photopeaks.  You can calibrate using 1 of two methods: 

a. You can click on the Auto button and the program should automatically set 
channel numbers for your peaks.   

b. OR you can manually put your cursor on the centroid of the lower energy peak.  
Highlight the 1173 peak entry in the calibration window.  Click the “Cursor” 
button.  This will enter the channel number of the peak. Repeat this for 1332 
keV. 

13. Record the channel and energy information. 
14. Use the Analyze tools to determine the peak area, uncertainty and FWHM of each peak.  

Record this data.   
15. Repeat sets 8 - 12 for Na-22 and Ba-133.  For Ba-133 using the Nuclide list the software 

will ask you to delete peaks that are near each other.  Select the peaks with the larger 
abundance. 

16. Plot the energy as a function channel (that you recorded) data in your notebook.  
Compare to this to the plot produced by Genie 2000 under Efficiency>Energy Show. 

17. Plot the FWHM as a function energy data in your notebook.  Compare to this to the plot 
produced by Genie 2000 (click on the Shape button). 

18. Is the channel to energy relationship linear?  What does the relationship look like for 
FWHM and energy? 

19. Move to the unknown source(s) in Position 5. 
20. Acquire a spectrum for 180 s. 
21. Based on this spectrum, determine what isotope the unknown source(s) is. Use the 

Options>Interactive NID tool to assist you. Make sure “Show confirming lines” is 
turned on, as this will cause it to show where other peaks from a given nuclide 
should be if it is actually in your sample.  Clicking on a line moves your 
spectrum cursor there, while clicking in the spectrum will choose a nuclide & 
line if it is close enough to one. 
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Efficiency Calibration 

1. Using the count rate data and the known source activities, calculate the efficiency of the 
detector system at each peak energy.  
2. Make a plot of the Efficiency as a function of Energy for your notebook.  
 
 

Potential Post-Laboratory Exercises 
1. Plot energy as a function of channel number 
2. Plot FWHM as a function of channel number 
3. Plot Efficiency as a function of channel number 

4. Write a full lab report explaining how the detector was energy calibrate 
and how this calibration was employed to identify an unknown source.   
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Laboratory 2 

Uranium Enrichment Measurements with HPGe’s 

Purpose 

The purpose of this laboratory is to gain operational experience with a HPGe detector. In 
this experiment, students will utilize a HPGe detector system and spectrum analysis 
software to identity and determine the activity of an unknown source.  In addition, 
students will use the simple comparator method to calculate the enrichment of various 
uranium samples.  

Materials Needed 

The following will be provided by the instructor: 

1. a natural uranium source
2. an enriched uranium source
3. a depleted uranium source
4. a HPGe detector
5. a high voltage power supply
6. Experiment station computer
7. a digital MCA system with spectrum analysis software

The student should have the following: 

1. an internet-capable computer
2. a copy of these procedures
3. a pen
4. your notebook
5. a calculator
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Position Source Half life 
(yr) 

Energy 
(keV) 

Branching 
Ratio 

1 Cs-137 30.1 662 0.85 

2 Eu-152 13.5 

122 0.29 
245 0.076 
344 0.27 
779 0.13 
964 0.15 
1086 0.10 
1112 0.14 
1408 0.21 

 
Table A1 – List of radionuclides used in this experiment. 

 

Experimental Procedure 

Connecting to the Experiment Station 

Your instructor will arrange for you a time to use the experiment station, an IP 
address to connect to, and login information for the experiment station.  Record 
this information, as you will need it to connect to the experiment station. 

 

Windows Instructions 

1. Connect to the Texas A&M network.  Help for this topic can be found at 
http://it.tamu.edu  

2. On your computer, open up the Start menu and search for Remote Desktop 
Connection and open it. 

3. Click on Show Options. Enter the IP address given by your instructor in the 
Computer: field and X\username into the User name: field, where X is the IP 
address and username is the login name supplied to you. 

4. Click Connect. It will shortly ask for a password, enter the one supplied by 
your instructor. 

5. You are now connected to the experiment station. Check that Canberra 
GENIE, LabView, and the webcam software are all open. If not, follow the 
shortcuts on the desktop to open these programs.  Open LabView using the 
“Spectroscopy Stepper” shortcut, then enable the VI by pressing the Run 
button in the upper left corner (Fig. A2).  Enable the motor itself as well. 
 
 

http://it.tamu.edu/
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Fig. A2 – The Run button on the left end of the toolbar. 

 

Create a library in GENIE 

1. On the lab computer’s desktop go to: START>All Programs>GENIE 
2000>Nuclide Library Editor. 

2. In the window that appears enter all possible source information.  To accomplish 
this, first fill out the top most portion of the window which contains the name of 
the isotope you are adding. Hit Add Nuclide.  You can leave uncertainty blank.  
Now fill out the energy line information and hit Add Line.  You can leave the 
“uncertainty” at 0.  Do this for each nuclide in Table A1.   

3. Add additional sources.  Go to Options > Extract.  Open Stdlib.nlb.  Click on 
Zn-65, Eu-152, Am-241 and Bi-214.  Hit OK.  Several peaks will show for each 
of these sources.  Delete lines that are less than 5% abundant. 

4. Now add U-235 and 238.   Go to Options > Extract.  Open 
ANSI_GammaGuru.nlb.  Select U-235 and U-238+dau.  Do not delete any peaks. 

5. Save your library as distance605lib. 
 

Energy Calibration 

1. Turn on the GENIE software.  Go to File > Open.  Select the Detector button 
and choose the HPGe .mid file.  Go to MCA > Adjust.  Change the LLD to 
0.5%.  Verify that the HV potential and polarity are properly set.  Turn on your 
HV.  Set the acquisition time to 120 s. (MCA > Acquire Set up…) 

2. Select the Cs-137 source and press Start Move.  Set your MCA to a 3 MeV 
scale.  Your maximum channel is 8192.  Make sure you record the centroid for 
the Cs-137 photopeak and show how you got to it in your lab notebook. 

3. Once your scale is set, acquire a spectrum for 120 s. 
4. Once 120 s has elapsed calibrate the spectrum. Calibrate > Energy Only.  Put 

your cursor on the peak centroid.  Click the Cursor button, then enter the peak 
energy.  Hit Accept.  Record the channel number of the photopeak, backscatter 
peak and Compton edge. 

5. Use the “Analyze>Peak Locate>Unidentified 2nd Differential…” command to 
perform a peak search. Remember to check the “Generate Report” box in order 
to tell GENIE to print the report to the window. Acquire the peak area for the 
spectrum using the “Analyze>Peak Area>Sum/Non-linear LSQ Fit…”.  
Record the net count rate and count uncertainties for the peak.   

6. Eu-152 Measurement.  Switch to the Eu-152 source.  Count the Eu-152 source 
for   180 s. 
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7. Using the Canberra GENIE-2000 software, add the Eu-152 photopeaks to the 
energy calibration for the detector system. You can do this by using the Energy 
Full > By Nuclide List command. Select your 605lib.  Remember to check 
“Append to Existing Calibration” so that it adds this calibration point to the 
existing calibration. Put the cursor on the spectrum over the peak centroid.  Click 
on the Cursor button. Record the channel and energy information.  Delete any 
peaks that do not have any relevance in your calibration. 

8. Use the “Analyze>Peak Locate>Unidentified 2nd Differential…” command to 
perform a peak search. Remember to check the “Generate Report” box in order 
to tell GENIE to print the report to the window. Acquire the peak areas for the 
Eu-152 peaks listed in Table 1 using the “Analyze>Peak Area>Sum/Non-linear 
LSQ Fit…”.   

 

Efficiency Calibration 

1. Go to Calibrate>Efficiency>By Nuclide list. Select Eu-152. Do NOT check 
“Append to existing calibration.” 

2. Click on the Additional Information button. 
3. Enter the assay date on the source.  For time enter 12:00:00.  
4. Enter the activity of the source and add an uncertainty of 10%. Click the Change 

button and the information should update in the window. 
5. Hit OK then hit OK in the remaining window.  The efficiency calibration 

window should appear.  Hit Auto on the bottom right of the window.  Your peak 
efficiencies should automatically fill in.  If they don’t, you may not have 
recorded the spectrum for long enough or your energy calibration is off.  

6. Once all of the efficiencies are entered hit OK. 
7. Go to Calibrate>Efficiency Show.  Record your efficiency curve. 
 

Identification of an unknown source. 

1. Switch to the unknown source.  Take a 300 s spectrum. 
2. Go to Analysis>Executive sequence>NID Analysis with Report. 
3. Record the peak energies of what was found, determine what nuclide is present 

and its activity. 
 

U Measurements 

1. Switch to the first uranium sample, natural uranium. This sample will serve as 
your standard. 

2. Acquire a spectrum for 10 minutes. This measurement time must be long enough 
that the 1001 keV peak for U-238 has a sufficient number of counts.  
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3. Go to Analysis>Executive sequence>NID Analysis with Report. 
4. Using the GENIE-2000 analysis software, identify the peaks in the spectrum. Use 

the Analyze>Peak Locate>Unidentified 2nd Differential… command to 
perform the peak search. Remember to check the “Generate Report” box in order 
to tell GENIE to print the report to the window. 

5. Record the peak energies of what was found, what the nuclides identified were 
along with the calculated activity.  Record the net area of the 186 keV and 1001 
keV peaks using the ROIs from the peak locate.  Keep these ROIs for the other 
uranium samples. Do not clear them. 

6. What activity for U-235 and U-238 did the software calculate?  
7. Repeat steps 2-8 for a second uranium sample. Skip peak locate. 
8. Using the simple comparator method discussed in class, estimate the enrichment 

of the second uranium sample. 
9. Repeat steps 2-8 for a third uranium sample. Skip peak locate. 
10. Using the simple comparator method discussed in class, estimate the enrichment 

of the third uranium sample. 
 

Potential Post-Laboratory Exercises 
1. Plot energy as a function of channel number 
2. Plot FWHM as a function of channel number 
3. Plot Efficiency as a function of channel number 
4. Create a table listing the energy of each of the Cs-137 spectrum: photopeak 

energy, Compton Edge and backscatter peak.  Compare the experimental 
energies to calculated energies from the Compton scattering formula. 

5. Create a data table for each efficiency measurement. 
6. Create a table showing the unknown source data and its identity. 
7. Create a table with uranium 
8. Write a full lab report explaining how the detector was energy calibrate and how 

this calibration was employed to identify an unknown source.  
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Laboratory 3 

Gas-Filled Detectors, Counting Statistics, and Dead Time 

Purpose 

The purpose in this lab is to introduce the student to gas-filled detectors and to learn how 
to interpret data from these detectors. The student will specifically learn about the 
Geiger-Mueller counter. The student will study the signal produced from this detector 
using an oscilloscope. The student will also study the statistics involved in radiation 
detection using the detector. The student will then learn how to characterize the detector 
efficiency and the detector dead time. These values will then be used to determine the 
activity of an unknown source using counts from the detector. 

Materials Needed 

The instructor will provide the following: 

1. A Geiger-Mueller counter
2. Lynx MCA
3. Experiment station computer

4. Tl-204 split source
5. Other radioactive source

The student should have the following: 

1. an internet-capable computer
2. a copy of these procedures
3. their notebook
4. a pencil
5. a calculator

The Student should know the following: 

1. Dead-time formula
2. How to calculate activity
3. Basic error propagation formula
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Experimental Procedure 

Connecting to the Experiment Station 

Your instructor will arrange for you a time to use the experiment station, an IP address to 
connect to, and login information for the experiment station.  Record this information, as 
you will need it to connect to the experiment station. 

 
Windows Instructions 

1. Connect to the Texas A&M network.  Help for this topic can be found at 
http://it.tamu.edu  

2. On your computer, open up the Start menu and search for Remote 
Desktop Connection and open it. 
3. Click on Show Options. Enter the IP address given by your instructor in 
the Computer: field and X\username into the User name: field, where X is 
the IP address and username is the login name supplied to you. 
4. Click Connect. It will shortly ask for a password, enter the one supplied 
by your instructor. 
5. You are now connected to the experiment station. Check that Canberra 
GENIE, LabView, and the webcam software are all open. If not, follow the 
shortcuts on the desktop to open these programs.  Open LabView using the 
“GM Rotate” shortcut as well as the “GM Linear” shortcut, then enable the VIs 
by pressing the Run button in the upper left corner.  Enable the motors as well. 

 

GM operating range 

1. With the Genie gamma acquisition software, open the detector MID file 
“OSPREY##” and set the HV to 500 V. (MCA>Adjust>HV). 

2. Make sure the detector is in “Position A” (in the Linear VI) and that the movable 
half of the split source is placed next to the stationary half (“Position 2” in the 
Rotation VI). 

3. Determine the operating voltage 
a. Set the software to record for 18 seconds (0.3 minutes). 
b. Starting at ~500 V increase your voltage 25 V until you register betas. 
c. Record the counts after every increase until you have left the GM region (This 

will occur when there is a sharp increase of counts). DO NOT EXCEED 1000 V 
4. Pick an operating voltage about half way into the plateau. 
5. If you see a decrease in the count, please provide the explanation. 
 

  

http://it.tamu.edu/
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Counting Statistics 

1.  Move the detector to Position A if it is not already. Take a 120 s background count, 
ensuring that the movable source half is not in front of it.  Record the count. 

2. Move the source to Position 1. 
3. Take 40 sequential 6-second counts of the movable source and record these raw 

counts N.  
4. Calculate the mean of these 40 counts Navg. Tabulate N-Navg.  

Note: The number (N-Navg) is called the residual and can be positive or negative. If 
you add up all of the (N-Navg) values in the table, the answer should be zero. If it is 
not, a mistake has been made. Calculate the standard deviation (σ) which is the 
square root of the mean. Sixty-eight percent of the observed data should lay within 
the range Navg+σ to Navg-σ.  

 

Detector Dead Time Measurements 

1. The source used so far is part of a split source set. This source is designed such that 
each half of the source can be counted separately without too many losses, but when 
both parts are counted at the same time, substantial losses occur. 

2. Count the movable half of the source at “Position A” for 30 seconds. Calculate the 
count rate and call this M1. Record the count time, counts, and count rate. 

3. Move the detector to “Position B,” where the other half of the split source is 
positioned. Count the second half of the source for 30 seconds (or the same time 
length used in step 2). Calculate the count rate and call this M2. Record the count 
time, counts, and count rate. 

4. Now count both halves of the source at the same time for 30 seconds.  With the 
detector still at Position B, move the second half of the split source to Position 2.  
This should place the sources together in front of the detector.  Calculate the count 
rate and call this M12. Record the count time, counts, and count rate. 

5. Move the detector back to Position A and count background for the same count time 
used above. Calculate the background count rate and call this Mb. Record the count 
time, counts, and count rate. 

6. From these values calculate the dead time.  
 

 
Potential Laboratory exercises 

1. Create tables of all the data 
2. Calculate the mean of these 40 counts Navg.  
3. Calculate N-Navg in the table. Note, the number (N-Navg) is called the 
residual and can be positive or negative. 
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4. Calculate the standard deviation (σ) which is the square root of the mean.  
Sixty-eight percent of the observed data should lay within the range Navg+σ to 
Navg-σ.  Is this the case? 

Calculate (N-Navg)/σ and tabulate them. Round off the value for each 
entry of (N-Navg)/σ to the nearest 0.5. For example, if (N-Navg)/σ = +1.11, then 
the rounded off value would be +1.0. Produce a histogram of the rounded off 
events and discuss. Hint: what should this histogram look like?   
5. What is the dead time?  What is the uncertainty in the value?  How does 
this dead time compare to the accepted dead time (cite where you got the 
accepted dead time)?  
6. Write a full laboratory report on the results of this lab. 
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APPENDIX B 

Block Diagram for the Linear Slide VI 
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Block Diagram for Rotary Table VI 
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